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Always bear in mind the following key words before, during and on 

completion of the development of a report: 

 

 Automation 

 Flexibility 

 Performance 

 Ease of use for future support/maintenance 

 

The purpose of this document is to provide the best possible guidelines on effective report 

writing.  These guidelines can be used to develop reports intended for deployment as 

opposed to developing a report that is customer specific. 

   

  

 

 

 

 
 
 

 

 

 

1.1 Pre-Requisites 

Prior to developing any report it is recommend that a comprehensive requirement document 

be completed in addition to the following:  

 Completion of Connector, Report Manager and Excel on Steroids training.  

 Adequate sample data. 

 SQL knowledge is recommended for Connector usage. 

 A sufficient Data Dictionary of the database being reported off. 

 ODBC drivers are installed if required for the application in question. 

 Examples of the desired output and layout required. 

 

 

1.0 Getting Started 
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Note: "Graphical Joins”, existing “SQL views” and “SQL Joins" are the 
preferred methods for creating containers and that wherever possible these 
should be used. Stored procedures and SQL query containers provide less 
flexibility for end users creating new or modifying existing reports off these 
containers.  

 

 

 

 

 

 

 

 

2.1 Containers 

When developing a container, the following criteria should be kept in mind: 

 Type of join to be used (e.g. SQL join, graphical join etc.). 

 SQL expressions should be used as often as possible as these have a faster run time 
as compared to Excel expressions and can also be used in aggregates. 

 Name containers as per the report name or similar to. This is for ease of use in 
recognising the contents of the container. 

 Include the appropriate ERP abbreviation and version number directly after the name of 
the container, e.g. A container for a Sage 300 SQL general ledger transaction report 
would be as shown below (“Name of container”, S300 SQL, Version) 

 

Figure 1: Integration container versioning 

 

 Where possible use SQL expressions to create calculated fields as opposed to using 
Excel formulas at the front end within Excel. 

 Provide meaningful descriptions on containers. 

 Include expressions with meaningful names in the container that may be useful to the 
client for future use even if they are not required on the report in question. 

 

2.2 Joins 

 Use Graphical Joins unless you require specific clauses within the join, as this creates 

a visual entity relationship diagram. 

 Views and Stored Procedures should only be used if designing a report from a database 

where such Views or Stored Procedures are standard within the database and not client 

specific. An exception would be if the need arises for an extremely complex report where 

the end result cannot be achieved in any other way. 

 For performance it is best to use index fields.  However, where joins are required on 

non-indexed fields it is recommended that the developer index the required fields. 

2.0 Connector 
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2.3 Expressions 

 Use data fields and SQL expressions as much as possible. 

 Pass through variables are a powerful feature but can make containers more complex 

to use. Only use them when there is no better way to achieve the same result. 

 Excel Formulas should be a last resort if the end result cannot be achieved through SQL 

expressions. Excel formulas have a negative effect on file size and performance. 

 Provide meaningful names for expressions and data fields, as often database fields are 

presented in a cryptic manner. 

 

2.4 LookUps: 

 Ensure that lookups are working properly on all expressions in the container and not 

just the expressions intended to be used in the report as other users may create reports 

off the container.  

 Where the functionality of the database allows for the use of the SQL distinct keyword, 

ensure that lookups display a distinct list of values. 

 For containers that access large data sets it is recommended that the SQL lookup type 

for all expressions be changed to ”Direct from Container” or “SQL Statement Defined”. 

This will optimise lookups and minimise the load on the database server. 

 Where necessary, set the lookup type to a Customised SQL Statement and customise 

the statement in order to achieve the preferred end result. The lookup of the expression 

does not always have to come from the table listed in the expression source; it can be 

set to obtain the value from a different table.  
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Note: 

 Before creating any reports ensure all expressions in the container are added to 
a report which is then run out.  This is done to ensure that all expressions are run 
out successfully. 

 Do not use macros. Sage Intelligence does not support the distribution of Report 
Sets with Reports that have calls to macros within them. All macro calls will be 
removed from reports during Metadata Compilation; this is as a result of macros 
referencing specific ranges. Should a user customise or alter a report that uses 
macros then this could cause macros to fail. Macros make reports impossible to 
support without advanced VBA skills.  

  

   

 

 

 

 

 

 

 

 

 
 

 

 
 
 

 The type of report being developed needs to be determined, e.g. a stand-alone report, 

union report etc.  

 It is recommended to document the reasoning for the use of a specific method in the 

developing of a report for future reference e.g. Union Report used because X and Y 

table could not be joined in a container. 

 Keep the number of reports per container to a minimum. It is recommended to duplicate 

a container if it is to be used for more than one report. This eliminates room for error 

when editing an expression.  If numerous reports are using the same container and the 

same expression, changing the expression for the purpose of one report could result in 

a negative impact on the other reports. 

 Assign a unique report code to each report:  

o Report codes are added to reports in the Report Manager on the Advanced 

properties screen of the report (i.e. select Show Advanced, then scroll down) 

o The report code should be made up as follows:  

The abbreviation of the application and application version, the database type, 

the system class followed by a number, then the report version e.g.  for Sage 

300 SQL General Ledger report the code would be similar to this: AE-SQL-

GL01-2-0  

 

Figure 2: Integration report versioning 

 

3.1 Parameters 

 Rename parameter fields on the parameters properties screen where necessary to 

provide more meaningful options to the user at runtime. Set “Parameters on Second 

3.0 Report Manager 
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Note: Union sub reports run in Reverse Order (LIFO) within a union report. 

 

Sheet” on. Having the parameter values within the workbook can be extremely useful in 

report headings. 

 Where possible, insert system variables in the report parameter defaults e.g. 

@MONTHEND@ to eliminate possible errors at run time. 

 

 
Figure 3: Report Parameter Defaults 

 

 Set each parameter field’s “Mandatory” tick box on  

 
Figure 4: Selecting the mandatory parameter option 

 

3.2 Union Reports 

 

 

 
 
 
 

 Place all parameters on the first union sub report which runs.  Should filtering be 

required on subsequent sub reports, Pass Through Variables can be used to pass these 

values through to filter in the sub reports. This will eliminate parameter pop ups later in 

the run process. 

 When adding a sub report to a union report, the reports are all set to run out on Sheet 

1.  The sub report run order can be amended by changing the “Output Sheet Number” 

on each union sub report. 
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Always bear in mind that if the “Parameters on Second Sheet” has 

been selected, no sub reports should be assigned to sheet 2 of the 

report 

 

 

 
Figure 5: Setting the sub report run order 

 
 
 

  
 
 
 
 

 When running out the report as seen in the graphic below, the Dashboard sub report 

will be on sheet 1, the parameters on sheet 2, the Dashboard Financials Grp sub report 

on sheet 3, etc. 

 

 
Figure 6: Report output order 

 

3.3 Union Sub Reports 

 

 Set “Report Hidden” on for all Sub reports, to eliminate confusion between the report 

and the sub reports making up that report.  By doing this, the sub report will not appear 

on the menu, but still be accessible via the tools menu.   
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 Sub report properties have an option to “Abort Union Report if No Data”.   This option 

should be checked on for any sub reports that must return data for a report output to 

make sense. Standard reports by default give a “No data” message when there is no 

data but since a union report pulls data from more than one report (e.g. a dashboard) 

you may still want to see the report even though some data is not there. There is 

however union reports that you would not want to run out if 1 or more of the sub reports 

don’t return data. An example would be a financial report that is a Union report. In these 

scenarios you should check this option for the sub reports. If there is no data for the sub 

report(s) then the report aborts. 

 

 
Figure 7: Abort Union Report option 

 

 “Allow Report Viewer and External Access” needs to be selected on the relevant 

reports.  This option must not be selected for drill-down and sub reports. This will 

ensure that the report is available through the SDK for use in application menus. 

 

 
Figure 8: Allow Report Viewer and External Access 

 

 It is recommended that all sub reports have the word “Sub” at the end of the report name 

to differentiate them from stand-alone reports that are intended to be run. Sub reports 

are not intended to be run as a stand-alone report. 
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PLEASE NOTE:  The following sections, especially regarding the Look and Feel are a 

guideline only for external users.  There are however, other suggestions in these sections 

which could prove valuable when creating a report. 

 

When developing a template, it is recommended to do so using the earliest possible version 

of Excel and to link the template back as an .xltx for a macro free Excel 2007+ report or 

.xltm for a macro enabled report.  This will ensure that the template is compatible on all 

versions of Excel.  Any Report Designer templates created need to be developed using 

Excel 2007and linked back as an .xltx file.  

 

4.1 Pivot Tables 

When using a PivotTable in the template file take the following into account: 

 PivotTable Limitations – ensure that you do not display too many row fields that could 

cause the pivot table limitation to be reached. Use page fields where necessary to 

further summarise data. 

 When pivoting data from a source data sheet where the data was rendered by Sage 

Intelligence, always use the named range Sheetname!RawData. This will ensure that 

the full range of data extracted is always available for use within the pivot table. When 

adding new columns to a report, these new columns of data will then automatically be 

included in the pivot table range. 

 

 
Figure 9: Selecting PivotTable Data Range 

 

 

 Ensure “Allow multiple filters per field” has been selected to ensure that multiple slicers 

can be created off one pivot table. 

 

4.0 Excel Template File 
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Figure 10: Number of items to retain per field  

 

 

 Suggested PivotTable settings: 

o Set the following footers on each page: 

 At the bottom left, set the date and time 

 At the bottom right, set page numbering 

o Set print titles to have row headings repeated at the top of each page. 

o Set print titles to have columns repeated at the left of each page where necessary.  

o Preview the report and adjust the scaling where necessary, but to a minimum of 

75%. 

o Reset margins where necessary. 

 Formatting should be uniform on all reports to ensure the end product has a consistent 

feel. 

 The pivot table style (under the Design menu tab) used in all pivot tables is the second 

grey style found under the Medium section)  

 

 

Figure 11: Pivot Table Style 
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4.1.1 Pivot Table Slicers 

 If the report is for Excel 2010 + and a slicer is used, the format to use is the 

Green style under the Dark section 

 

 

Figure 12: Pivot Slicer Style 

 

 Ensure the “Hide items with no data” has been selected in the Slicer Settings to 

ensure that items relevant to other data sets are not retained in the slicer. 

 
Figure 13: Pivot Slicer Settings 

 

 

 If the report is for Excel 2013+ and a timeline is used, the format to use is the Green 

style under the Dark section 
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Figure 14: Pivot Timeline Style 

 

 All other formatting, e.g. font, font size, font colour, etc. should be consistent throughout 

the report. 

 

4.2 Power View 

 When formatting any Power View report ensure that either the Theme 4 or Slipstream 

theme has been used. 

 

Figure 15: Power View Theme 

 

 

4.3 Pivot Charts 

Do not use Pie Charts or donut charts as the data labels may become distorted due to 

different data scenarios. 

 

All areas of a pivot chart can be formatted.  To format the various sections of a pivot chart: 

 Data Series – right click on the data bars and select Format Data Series 
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Figure 16: Format Axis 

 

 Select Fill and Vary colours by point to format the data series 

 

 
Figure 17: Format Data Series 

 

Data labels are not needed on all charts.  When using data labels ensure that they are 

required for the specific chart, that using them will give the user a better visual of the data 

being displayed and that they will not overlap when used with different data scenarios.  

 

 Vertical and Horizontal Axis – right click on the axis labels and select Format Axis.  

Axis labels should always be set to “Low”.  This will ensure that the labels are 

displayed correctly when the data contains positive and negative values. 
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Figure 18: Format Axis 

 

 Select the gridlines of the pivot chart and press Delete to delete them 

 

 
Figure 19: Delete Gridlines 

 

 Right click in the legend to format 

 

 
Figure 20: Format Legend 

 

 To remove the border, right click in the Chart Area and select Format Chart Area 
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Figure 21: Select Format Chart Area 

 

 Select Border Colour and No Line to remove the outline 

 

 
Figure 22: Set Border Colour to No Line 
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4.4 Excel Formatting 

 

 Set report headings at the top of each worksheet that is used as a final end result.  

Include parameter values within the report headings where necessary. 

 All headings are to be in Segoe UI font with the main heading set to size 24 and the sub 

heading set to size 16. 

 The main heading is to be in Sage Bright Green (52 / 178 / 51) and the sub heading in 

Sage Dark Grey (77 / 79 / 83). 

 The body of the report is to be in Arial with a font size of 10 and black (Automatic). 

 Set “Freeze panes” to enable easy scrolling around the worksheet without losing view 

of report headings etc. 

 Hide the display of zero values on the worksheets. 

 Hide the display of gridlines on the visible worksheets. 

 Adjust the zoom display if necessary but to a minimum of 75%. 

 Ensure the correct worksheets in the workbook have been hidden. 

 The template is to be saved on the correct worksheet with the cursor position in the first 

blank cell. 
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When developing a template for integrations, the report needs to be developed on the 

earliest possible version of Excel and to link the template back as an .xltx for a macro free 

Excel 2007+ report or .xltm for a macro enabled report.  This will ensure that the template 

is compatible on all supported versions of Excel.  Any Report Designer templates created 

needs to be developed using Excel 2007and linked back as an .xltx file. Ensure that the 

Excel Colours Theme is set to Office 2007 – 2010 under the Page Layout menu option. 

 

Figure 23: Page Layout Theme 

 

5.1 Fonts 

The font style applies to reports created for both integrations and the Free Template 

Store. 

 

Headings are standard across all reports and in all Excel versions: 

 

 
Figure 24: Headings 

 

All other text is in Arial with a font size of 10 and colour black.  It should be noted that 

the font for the body of the pivot table will automatically take on the format specified in 

the Excel Default settings which is found on the Home tab under the Normal style 

section. 

5.0 Look and Feel - Desktop 
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Figure 25: Excel Default Font 

 

 

5.2 Pivot tables 

If the report is for Excel 2010 + and a slicer is used, the format to use is the Green style 

under the Dark section 

 

 
Figure 26: Pivot Slicer Style 

 

 If the report is for Excel 2013+ and a timeline is used, the format to use is the Green 

style under the Dark section 

 

 
Figure 27: Pivot Timeline Style 
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Figure 28: Excel 2007 

 

 
Figure 29: Excel 2010 

 

 

 

 

 

6.0 Examples of workbooks in each version of Excel 
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Figure 30: Excel 2013 

 

6.1 Dashboards 

 

For Dashboard reports, we should attempt to create a dashboard as the one shown in 

Figure 44.1.  However, if your group headings are unable to fit in your header row 

without compromising the 75% page view, then you can use the Dashboard layout in 

Figure 44.2. 

 

 
Figure 31.1: Dashboard Layout A 
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Figure 31.2: Dashboard Layout B 

 

 

 

6.2 Designer Layouts 

 

The Financial Report Designer Task Pane layouts will retain the current look and feel as 

the Layout Generator layouts are formatted in the backend. 

 

 
Figure 32: Financial Report Designer 
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7.1 Theme Selection 

 

Theme must be slipstream 

 
Figure 33: Colour Theme 

 

 

7.2 Pivot Tables 

 

Choose Medium 7 as your base pivot table. 

 

 
Figure 34: Pivot Table Colour Theme 

 

 

 

 

 

 

 

7.0 Look and Feel - Online 
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Duplicate this pivot table style 

 

 
Figure 35: Duplicate Pivot Table Style 

 

You will be prompted to modify the pivot table style. Go to Heading Row as seen below 

and click format. 

 

 
Figure 36: Modify Pivot Table Style 

 

 

Go to the fill option and set the fill to 77 79 83 (Sage Dark Grey) 

 

 
Figure 37: Fill colour 
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Go to Row Subheading 1 

 

 
Figure 38: Modify Pivot Table Style 

 

 

Set fill to No Colour 

 
Figure 39: Set Fill colour 

 

Select your new Pivot Table Style for your pivot table. 

 

 
Figure 40: Custom Pivot Style 
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This can be reused for all your reports. 

 

 

7.3 Charts 

 

Start with a pie chart but do not retain them in your report. 

 

Always start with a pie chart if you want your chart to contain data labels, and select style 

3 to begin 

 

 
Figure 41: Pie Charts 

 

 

 

Right click on chart and select the “Format Chart Area” option, select no fill and no line as 

seen below. Do the same for the legend for your chart. Delete your chart title. 

 

 
Figure 42: Format Chart Area Fill Settings 
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Format your data labels and legend to Arial 10 and then Your Pie Chart should look like 

the below 

 

 
Figure 43: Format Chart Area 

 

 

From here you can change your chart type if you need to by right clicking on the chart. 

 

 
Figure 44: Change Chart Type 
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Bar Charts and Column Charts 

 

 
Figure 45: Bar & Column charts 

 

 

No gridlines, Text on X and Y axis must be Arial 10 black.   

Axis label must be set to low 

 

 
Figure 46: Format Axis 
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7.4 Slicers 

 

Timelines will sometimes vanish on Excel Online so do not use them. 

 

 

Slicers must use the below style. To get this style available in your workbook, you have to 

copy and paste a slicer with this format into your workbook (Slicer can be found in Sage 

One Reports). 

 

 

 
Figure 47: Slicer style 

 

 

Thereafter the slicer style should be available in your slicer options. 

 

 
Figure 48: Slicer style Options 
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7.5 Financial 

 

7.5.1 Layouts 

 

 
Figure 49: Financial Layout 

 

 Heading : Segoe UI 24 – Sage Bright Green – R52 G178 B51 

 Parameters : Segoe UI 16 – Sage Blue – R0 G159 B218 

 Parameter Name : Arial 10 bold – Black 

 Parameter Value : Arial 10 – Black 

 Rows – Arial 10 

 Subtotal Rows – Arial 10 Bold – Black – Fill : Sage Light Grey – R224 G225 B221 

 Columns Headers : Segoe UI 11 – White 

o Fill Primary – Sage Bright Green  - R52 G178 B51 

o Fill Secondary – Sage Dark Green – R0 G127 B100 

 

 

7.5.2 Sparklines 

     

 
Figure 50: Sparklines 
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 Heading: Segoe UI 11 – White - Fill - Sage Blue 

 Line Weight: 2.25 point 

 Line Colour: Sage Bright Green 

 High Point: Sage Blue 

 Low Point: Sage Orange R255 G88 B0 
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8.1 Key Words 

All key words are to be in capital letters: 

 

SELECT  

RTRIM(Table1.Expression1) 

FROM  

Table1 

WHERE Table1.Expression1 = 1 

 

8.2 Aliases 

All Aliases to be encapsulated in square brackets. 

 

SELECT  

Table1.Expression1 AS [Name] 

FROM  

Table1 

 

8.3 Indentation 

8.3.1 Expressions for SQL Query Type Containers 

For the purpose of readability and code comments where applicable, expressions should 

each be on its line. 

 

SELECT   

  Table1.Expression1  

, Table1.Expression2   

, Table1.Expression3   

FROM  

Table1 

 

8.3.2 Case Statements  

Logical tests and their outcome should remain on the same line. 

 

SELECT   

CASE WHEN Table1.Expression1 = 1 THEN 100  

          WHEN Table1.Expression1 =2 THEN 200  

          ELSE 0  

END AS [Name] 

FROM  

Table1 

 

 

 

 

 

8.0 Report Writing SQL Standards 
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8.3.3 Joins 

Join Statements need to be indented as follows 

SELECT   

Table1.Expression1 

FROM  

Table1 

  INNER JOIN Table2 

                 ON Table2.Expression1 = Table1.Expression1 

             INNER JOIN Table3 

                 ON Table3.Expression1 = Table2.Expression1 

 

 

8.3.4 Where clause  

Where clause conditions are to be on their own line.  This is to make it easier when 

reading, commenting or omitting a clause. 

 

SELECT   

Table1.Expression1 

FROM  

Table1 

WHERE Table1.Expression1 >= 1  

AND Table1.Expression1 <=100 

 

 

8.3.5 Subqueries 

 

LEFT JOIN (SELECT  

                  Table1.Expression1 

                  ,Table1. Expression2 

                  FROM  

                   Table1 

                   WHERE  

                   Table1. Expression1= 0 

                   ) as TableSub1 

        ON TableSub1.Expression1 = Table2.Expression1 
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Connect with us 
 

 

Subscribe to Excel Tips and Tricks 

www.sageintelligence.com/blog/subscribe/ 

 

Sage Intelligence Blog 

http://www.sageintelligence.com/blog/ 

 

Sage Intelligence Community 

http://www.sageintelligencecommunity.com 

 

Subscribe to Sage Intelligence Tips and Tricks 

http://www.sageintelligence.com/blog/subscribe/ 

 

 

 Twitter 

twitter.com/sagealchemex 

 

 Facebook 

  www.facebook.com/sageintelligence 

 

 YouTube 

 http://www.youtube.com/user/SageIntelligence 

 

 LinkedIn Group 

 za.linkedin.com/company/sage-alchemex 
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